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• Introduction •

Overview
Crystal Reports for Peachtree is a special version of the popular Crystal Reports® 
report writer designed to work with Peachtree. The program is powerful yet 
flexible, letting you customize reports using virtually any of the information 
available in your company database.

Crystal Reports for Peachtree comes with six predesigned reports that small 
businesses find useful. If you want to design your own reports, the program 
automates the design process, providing a Report Expert that will guide you step 
by step. But for those special cases where a report requires a unique design, the 
Report Designer lets you put together text (such as headers or titles), maps or 
graphs, images (such as company logos), and of course database elements just 
as you want them to appear on the printed report. Then you can preview the 
report to make sure it looks as you expect.

If you haven’t already installed the Crystal Reports for Peachtree program, 
follow the instructions in the Crystal Reports User’s Guide, the chapter entitled 
“Installing Standalone Crystal Reports.” Once the program is installed, you can 
launch it directly—either from the icon on your desktop or from the Windows 
Start menu—to design, edit, and print all types of reports required by your 
business. For added convenience, you can also access the program while 
working in Peachtree. See the illustration of the Peachtree Reports menu  on 
page 5.

What’s in This Guide

The Crystal Reports for Peachtree Getting Started Guide includes the following 
sections:

Chapter 1: Introduction This chapter gives you a program overview, a brief 
description of the six standard Crystal reports, and a section devoted to using 
the program in a network environment.

Chapter 2: Previewing Crystal Reports This provides a discussion and 
illustration of the standard reports included with the program. It also tells you 
how to preview these reports using the Crystal Viewer.

Chapter 3: Designing Crystal Reports: A Tutorial This briefly describes the 
Crystal Report Designer and discusses how Crystal reports incorporate your 
Peachtree database information. Then we walk you through the process of 
modifying and designing Crystal reports:
2



Overview
What’s in This Guide
• In Lesson 1 you learn how to change the Crystal inventory labels into 
price tags. 

• In Lesson 2 you learn how to create a customer contact list from 
scratch.

• In Lesson 3 you learn how to use the Crystal Report Expert to design a 
list of customer quotes filtered by expiration date.

The guide you are reading is only a supplement to the Crystal Reports User’s 
Guide, which comes with the Crystal Reports for Peachtree program. For 
detailed information on working with the program, consult this guide. When 
additional information is available either in the Crystal Reports User’s Guide or 
online, we will cross-reference it. Be sure to watch for cross-references as you 
read.

Note
3
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The Standard Crystal Reports

The Crystal Reports for Peachtree program comes with six standard, 
predesigned reports. 

• Customer Detail List—This lists a variety of formatted detail 
information about your customers.

• Customer Sales by Item—This lists stock items your company has 
sold in the current accounting period and the customers who have 
bought them. The list is sorted by item rather than by customer.

• Inventory Labels—These are for marking inventory items so they can 
be stocked in their proper location. The labels print on standard 
3 across x 10 down label forms.

• Purchases by Unit Price—This lists, for the current accounting 
period, unit prices of stock and non-stock items you have purchased 
and the vendors who sold them. The list is sorted by item rather than 
by vendor.

• Vendor Detail List—This lists a variety of formatted detail 
information about your vendors.

• Void Check Register—This shows only your company checks, for the 
current accounting period, that have been voided.

Where the Reports Are Stored

When you install the Crystal Reports for Peachtree program, these six reports 
are automatically copied to all of your company subdirectories. So, for example, 
if you have five companies in Peachtree, the standard reports will be copied to 
each of the five company subdirectories. In addition, a Zip file containing the six 
standard reports is automatically copied to your Peachw/Reports directory; the 
name of this file is REPORTS.ZIP. 

If you alter or delete the original standard reports, you can always Unzip this file 
and copy the reports to your company subdirectory, where you’ll be able to 
access them in Peachtree. In order to Unzip the file, you will need a copy of the 
WinZip® program installed on your computer. You can download a free copy 
of the program from the Internet at www.winzip.com.

When you create custom reports or when you download new standard reports 
from the Peachtree Web site, you must always copy them to your company 
subdirectories before you can work with them in Peachtree.Note
4
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How to Access the Reports
How to Access the Reports

As with all Peachtree reports, you can access the standard Crystal reports from 
both the Reports menu...

...and from the Select a Report window.

The Crystal Reports
option opens the

Select a Report
window with the

Crystal Reports area
preselected

(highlighted); see the
illustration below.

The Crystal Reports
Designer option
opens the Crystal

Reports for Peachtree
program, where you
can select an existing

report or design a
new one.
5
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You can select a Crystal report from the Report List just as you would any 
Peachtree report. If you right-click on a selected Crystal report in the list, you 
will see a popup menu featuring Print, Preview, Design, and What’s This? 
Help options.

• For more information on using the Print option, look up “Print dialog 
box” in the Crystal Reports for Peachtree Online Help index. See also 
the “Introduction to Reporting” chapter in the Crystal Reports User’s 
Guide.

• For information on using the Preview option, see “Previewing Crystal 
Reports” on page 17 of this guide.

• For more information on using the Design option, look up “Design 
tab” in the Crystal Reports for Peachtree Online Help index. See also 
the “Introduction to Reporting” chapter in the Crystal Reports User’s 
Guide.

• For more information on selecting reports and working in the 
Peachtree Select a Report window, see the Peachtree User’s Guide, the 
“Reports” chapter.
6
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Using Crystal Reports in a Network
If you are working in a network environment, special conditions apply for the 
Crystal Reports for Peachtree program.

Special Network Conditions

The program must be installed on all machines The program needs to be 
installed on all networked machines where it will be used; the program will not 
work properly if installed on and accessed from a central server. 

However, so that more than one person can have access to Peachtree data and 
Crystal reports, you can copy these to a central server. Say you store your 
Peachtree data on drive E on the server. The data path to your Peachtree data is 
E:\PEACHW\DATA, and the data path to your company data is 
E:\PEACHW\<COMPANY>, where <COMPANY> is the name of the folder 
where your company files are located. Into this folder you should copy all 
Crystal reports that apply to the company. 

Now all machines with access to the data path E:\PEACHW on the server will 
have access to both Peachtree data and Crystal reports. For more information 
about sharing Peachtree data in a network environment, look up “Network: 
About Peachtree in a Network Environment” in Peachtree Help.

Standard Crystal reports are read-only When Peachtree is installed, the 
standard Crystal reports described in this chapter are installed as read-only files 
in all company subdirectories. This means that anyone working in the Crystal 
Reports for Peachtree program will be able to preview the reports but will not 
be able to edit and then save them. That way, you will always have the standard 
reports in their original condition so you can use them as templates for custom 
Crystal reports. 

If you are working in Crystal Reports for Peachtree and try to edit and then save 
a standard report, you will see an error message stating “This report could not 
be opened for writing. Any changes must be saved to a new file.” 

If you want to save your changes, use the Save As option on the File menu to 
save the file under a new name. Once saved, this new custom report will be fully 
editable.
7
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Write access is limited to the first user only When you create new custom 
Crystal reports based on the standard ones, you will be able to edit and save these 
new reports as desired. However, if more than one person is working with the 
same custom report in Crystal Reports for Peachtree, only the first user to access 
the report will have “write access”—that is, be able to edit and save the report. 
All other users will have read-only access and will be able only to view and print 
but not save the report, whether in preview or in design mode.

Limit Data Access to One User

Through Maintain Users, Peachtree allows you to set up user passwords and 
limit access to areas of the program. If desired, you can limit access to Crystal 
Reports for Peachtree, at least for design purposes, to only one user. To give just 
one user data access to Crystal Reports, enter a maximum eight-character 
password for that user, and then select the Limit data access from Crystal 
Reports to this user only check box.

Now, all users will be able to preview or print a Crystal report. However, when 
any user tries to refresh the data in a Crystal report using the Refresh button in 
the Standard toolbar, the program will request a password. If the password 
entered does not match the password set up for one-user access, then the user 
will not be able to refresh the report data and thus potentially use different 
parameter values to filter the data that appears in the report.

For more information about the Maintain Users window and setting up 
users, click the Help button in the window. See also the Peachtree User’s Guide, 
the “Company Administration” chapter. For more information about 
refreshing report data in Crystal, look up “Refreshing data:report data” in the 
Crystal Reports for Peachtree Online Help index.
8



2
Previewing Crystal 
Reports

Standard Crystal Reports
Customer Detail List 10

Customer Sales by Item 12

Inventory Labels 13

Purchases by Unit Price 14

Vendor Detail List 15

Void Check Register 16

Previewing Crystal Reports
Set Up Reports to Appear in Preview Mode 17

A Note about Printing Standard Crystal Reports 18



Previewing Crystal Reports
Crystal Reports for Peachtree Getting Started Guide2
• Previewing Crystal Reports •
This chapter describes and illustrates the standard reports that come with the 
program. It also tells you how to preview reports using the Crystal Viewer and 
provides an overview of report printing.

Standard Crystal Reports
The following six reports are shipped with Crystal Reports for Peachtree:

Customer Detail List

This report lists detail information about customers you have added to 
Peachtree through Maintain Customers/Prospects.
 

10
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Customer Detail List
The report includes the following information for each customer:

• Customer ID and name

• Bill-to and ship-to addresses

• Contact Person

• Phone Number 1 and 2

• Fax Number

• E-mail Address

• Web Address

• Prospect (yes/no)

• Customer status (active/inactive)

• Customer Type

• Customer Since date

• Tax location

• Resale Number

• Open purchase order number

• Credit Limit

• Pricing Level

• GL Sales Account

• Sales Rep Name

• Sales terms

• Sales Tax ID

• Last Invoice Date

• Last Invoice Number

• Last Payment Date

• Last Payment Amount

• Last Statement Date

• A listing of all custom fields
11
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Customer Sales by Item

This report lists stock items sold and the customers sold to within a selected date 
range. The report is sorted by item rather than by customer.
 

The report includes the following information:

• Inventory ID and Description

• Customer ID

• Date of sale

• Invoice number

• Quantity sold
12
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Inventory Labels
Inventory Labels

These are labels you place on items so that they can be stocked in the proper 
location at your storage facility. The labels print 3 across x 10 down (30 per 
page) in the LL-30W laser label format available through the Peachtree 
BusinessChecks & Forms catalog. Each label lists the following information:

The labels print 30 per page in the LL-30W laser label format available through 
the Peachtree Business Checks & Forms catalog. 

For ordering information, consult the catalog or look up “Peachtree Checks and 
Forms” in Peachtree Help.

Each label lists the following information:

• Item ID

• Item description

• Vendor ID

• Location
13
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Purchases by Unit Price

This report lists the unit prices of stock and non-stock items purchased and 
vendors purchased from within a selected date range. The report is sorted by 
item rather than by vendor. Use the report to check which vendors are offering 
the best pricing on an item.

The report includes the following information:

• Item ID and Description

• Date of purchase

• Vendor ID

• Invoice number

• Quantity

• Unit price

• Total purchase amount
14
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Vendor Detail List
Vendor Detail List

This report lists detail information about vendors you have added to Peachtree 
through Maintain Vendors. 

The report includes the following information for each vendor:

• Vendor ID and name

• Address

• Contact Person

• Fax Number

• E-mail Address

• Web Address

• Phone Number 1 and 2

• Fax Number

• Vendor Type

• Federal ID Number

• Vendor Since date

• Company account number

• Balance
15
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• Credit Limit

• Purchase Account

• Terms

• A listing of all custom fields

Void Check Register

This report lists all disbursement and payroll checks that have been voided 
within a selected date range. 

The report includes the following information:

• Check number

• Void date

• Payee (employee name, vendor name, or customer name)

• Cash account

• Check amount
16
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Previewing Crystal Reports
The standard reports that come with Crystal Reports for Peachtree are designed 
to open in preview mode. This is so you can preview them when you select them 
either in the Peachtree Select a Report window or in Crystal Reports’ Report 
Designer. The Save data with report option in the Crystal Reports File menu is 
turned on for each of the six standard reports; this is what allows them to be 
previewed. 

Set Up Reports to Appear in Preview Mode

If you turn off the Save data with report option and then save a standard report, 
when you open it again either in Peachtree or in Crystal Reports, the report will 
open in design rather than preview mode. So if you want the standard reports to 
open in preview mode, be sure to leave the Save data with report option turned 
on. With the option turned on, you can preview a Crystal report the same way 
you do other Peachtree reports. 

Do one of the following:

• click the name of a Crystal report in the Select a Report window and 
then click the Preview button

• double-click the report name with the left mouse button
17
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The Crystal Reports Design window appears with the report displayed on the 
Preview tab.

For more information on using the Crystal Reports for Peachtree Preview 
tab, look up “Preview Tab” in Crystal Reports for Peachtree Help. See also the 
Crystal Reports User’s Guide, the “Introduction to Reporting” chapter.

A Note about Printing Standard Crystal Reports

All standard Crystal reports are set up with no default printer chosen. So when 
you print using either the Print button in the standard toolbar or the Print 
option in the File menu, Crystal Reports for Peachtree will display a message 
telling you that no printer has been configured for the current report.
18
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A Note about Printing Standard Crystal Reports
• To print the report using the default printer you have set up with the 
Windows Settings>Printers option, select Yes.

• To set up a new printer for the report, select No.

Note that the No Printer check box is checked, indicating there is no printer 
configured for this report.

You can clear the No Printer check box, and then using the Name drop-down 
list, select a printer to use for printing the report. Set any other print attributes, 
such as double-sided printing, using the Properties button. Now, if you leave 
the Default Properties check box checked, the report will always print using the 
printer you have set up.

Clear the No Printer
check box...

...select the printer
your want to use...

... and make sure that
the Default

Properties check box
stays checked so that

Crystal Reports for
Peachtree will always

use this printer to
print the report.

Use the Properties 
button to set any 
special print 
attributes, such as 
double-sided printing.
19
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• Designing Crystal Reports:
A Tutorial •

Overview
When you design a Crystal report, you have a choice of either manually selecting 
the elements that will go into it or of automating the design process by using 
Crystal Reports for Peachtree’s Report Experts. Through a series of tabbed 
windows, the Report Experts guide you in every step of the design process. If you 
want to manually construct the report, Crystal’s Select Expert, Formula Expert, 
Section Expert, and Format Editor will help you choose exactly which data 
elements and formatting you want to appear in the report. 

Information on how to use these special features is beyond the scope of this 
guide. Instead, see the Crystal Reports User’s Guide, or look up the name of the 
specific feature in Crystal Reports online Help. However, in this chapter we give 
you an introduction to some of Crystal’s design features in the form of a brief 
tutorial that walks you through the process of designing your own Crystal 
reports. We also show you how to customize one of the standard reports that 
come with Crystal Reports for Peachtree. After completing the tutorial, you’ll 
have a better idea of how Crystal works and how to get your reports to include 
the precise data and formatting you want them to.

Before we start the tutorial, we explain some terms that will help you understand 
how Crystal reports incorporate database information; then we tell you how to 
add and link database information in a Crystal report.

Data Dictionaries

A data dictionary is a structured, simplified, and secure view of organizational 
data that an employee can use to create custom reports for your company. A 
dictionary gives the employee ready access to the data in an understandable 
form while ensuring control and security over your data resources, since the 
employee can in no way alter the original data. Using a dictionary, the employee 
can

• design a single, dynamic view of all the data that is necessary to create 
organizational reports and queries

• include multiple data sources, tables, and links 

• organize the data and rename tables and fields to make it easier for 
company employees to understand the content and purpose of the data 

• limit access to specific columns of data (for example, letting only 
managers see the salary column of the employee data files) 
22
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• place restriction formulas on specific rows of data (for example, 
allowing managers to view employee information only for those 
employees with a salary under $40,000)

• create complex data-manipulation formulas that employees can access 
without requiring a technical grasp of the formulas

Data Dictionary Files (DDFs)

Each data dictionary is made up of data dictionary files (DDFs). Crystal Reports 
for Peachtree comes with a special dictionary made up of three DDFs that 
contain much of the company information you would want to include in your 
reports. These three DDFs are called Field.DDF, Index.DDF, and File.DDF. 
(Note that while the program comes with three DDFs, you should make use of 
just the file called File.DDF—more about this below.)

In turn, each of these DDFs contains a series of subfiles with a .DAT extension. 
These subfiles contain a variety of company database information in the form of 
fields. For example, one .DAT file called Company.DAT contains fields that 
represent general information about your company, such as company name and 
address. Another data file called Project.DAT contains information about your 
company’s jobs, including job IDs, descriptions, and start and end dates. 

For a listing of all available .DAT files and the fields they contain, look up 
“.DAT Files” in Crystal Reports for Peachtree online Help.

Tables and Links

Within the Crystal Reports for Peachtree program, the information contained 
in any of these .DAT files is available in the reports you work on. You import the 
information into Crystal in the form of database tables. 

Not only can you import database information into your report, you can link 
related fields within the database tables you import. These links help you match 
related pieces of information for reporting purposes. For example, links can 
help you match a vendor to the inventory items the vendor supplies.

The following section outlines how to select and link tables used in Crystal 
reports. For more detailed information, see the Crystal Reports User’s Guide, the 
“Understanding Databases” chapter.

How to Add Tables and Make Links

To add linked database information to your report, follow these steps:

1 Select the Database menu, and then select Add Database to Report. 

The Crystal Data Explorer window appears.
23
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2 Find the Database Files folder in the list, and double-click to open it.

3 Double-click the Find Database File option.

4 In the Open window, use the Look in drop-down list to navigate to the folder 
containing your Peachtree company files.

The window displays the three Crystal Reports for Peachtree DDFs.

5 Select File.DDF, and then select the Open button.

While the Open window will show all three DDFs that come with the Crystal 
Reports for Peachtree program, you should always select File.DDF.

Crystal Reports will give
you three DDFs to choose

from in your Peachtree
company folder, but be

sure always to select
File.DDF.

Note
24



Overview
Tables and Links
6 The Data Explorer window returns with the contents of the DDF displayed as a 
series of tables.

These tables correspond to the .DAT files mentioned above, the ones 
containing company database fields. For example, the Company table 
contains all the company fields present in the Company.DAT file, and the 
Employee table contains all the payroll fields present in Employee.DAT. 

7 Select as many tables in the list as you want to include in the report. To select 
a table, do one of the following:

• highlight the table and click Add

• highlight and double-click the table

8 When finished, select Close.
25



Designing Crystal Reports: A Tutorial
Crystal Reports for Peachtree Getting Started Guide3
The Visual Linking Expert appears. All the tables you have chosen are 
displayed at the center of the window. If the Smart Linking feature is 
turned on, the Expert automatically links all fields capable of being linked. 
(Using the Smart Linking feature is much the easiest way to link fields, but 
you can do it manually if you like.) 

You can make new links or dissolve old ones as explained in Crystal 
Reports Online Help. Select the Help button in the Visual Linking Expert 
window.

The reason you link related fields across tables is so that the data 
represented by the fields can match up in meaningful ways within your 
report. For example, you would probably want to link the Customer 
Record field in the JrnlRow database table to the Customer Record field 
in the Customer table. This way, transaction information for each 
customer would be credited to the proper customer ID in the report.

9 When finished working in the Visual Linking Expert, select OK to close the 
window.

Once you have made meaningful links among fields in the database tables, you 
are ready to insert the fields into your report. Using the Crystal Reports Field 
Explorer, you just plug one of the fields into the report wherever you want 
specific database information to appear. For example, to insert a customer ID 
into your report, you would select the CustomerID field in the Field Explorer 
window, then drag and drop the field into your report.

If Smart Linking is turned
on, the Visual Linking

Expert will automatically
make links between

appropriate fields in the
chosen database tables.

You can add or delete links
using the options in the

window.
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For instructions on working in the Field Explorer, select the Help button at the 
bottom of the window.

We’re Ready to Start the Tutorial...

Now that you understand a bit more about using Peachtree database 
information in Crystal Reports, we can start putting together custom reports. As 
mentioned at the beginning of this chapter, in Crystal Reports you have the 
choice of manually building a report from scratch or of letting the Crystal 
Report Expert step you through the process. In this tutorial, we’ll do both:

• In Lesson 1 we’ll customize an existing standard report, inventory 
labels.

• In Lesson 2 we’ll design a Customer Contact List from the ground up. 

• Finally, in Lesson 3 we’ll use the Report Expert to craft a Quotes by 
Expiration Date List.

To insert a field, 
just select it in 
the Field 
Explorer, then 
drag and drop it 
into the report.
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Lesson 1—Modifying Inventory Labels to Create Price Tags

As a warm-up exercise, we’ll convert one of the standard Crystal reports. We’ll 
turn the inventory labels into price tags that can be attached to sale merchandise.

Use “Save As” to Create a Working Version of the Report

Since the standard reports are read-only versions (you can’t edit them in any 
way), we need to create an editable version of the inventory labels.

1 If Crystal Reports isn’t currently running on your computer, start it now.
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Use “Save As” to Create a Working Version of the Report
2 Select More Files, and then navigate to the BCS folder in the Peachw 
directory; this is where Bellwether Garden Supply company data is located. (If 
Crystal Reports is already running, select Open in the File menu, and then 
navigate to the Bellwether company folder.)

3 From the list of reports, select Inventory Labels.
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4 The message tells you that you cannot write to (edit) the report. Click OK.

5 To save the report in editable form, from the File menu, select Save As.

6 In the File name box, enter “Price Tags,” keeping the .rpt extension; see the 
illustration above. Then select Save.

When you enter the new
filename for the file you
want to save, be sure to
retain the .rpt extension.
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Modify the Labels to Create Price Tags
Modify the Labels to Create Price Tags

We’re now ready to start working on our new creation.

1 Select the Design tab.

2 We won’t need the Vendor ID or Location fields, so place the cursor in the 
gray area that reads “Details d” and right click.

3 From the pop-up menu, select Delete Section.

Working with report sections is an important concept but is beyond the scope 
of this guide. For more information, see the Crystal Reports User’s Guide, the 
“Introduction to Reporting” chapter.

4 We want to keep the section marked “Details c,” so just select the Vendor ID 
field.

 An object frame appears around the field, and the cursor turns into a cross 
with four arrowheads. The field is now editable.

5 Right click, and from the pop-up menu, select Delete.

The field is deleted.

Note
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6 Select the Insert Fields button in the Standard toolbar.

7 Double-click the Database Fields folder to open it, and then double-click the 
LineItem table to open it.

8 Find the UnitPriceLevel1 field; select it; and drag it into the Detail c section. 
Release the mouse button. You can close the Field Explorer window.

9 Now we want to modify the font used for the Description field. Select the 
field, and then right mouse click.

10 From the pop-up menu that appears, select Font.

Double-click both the
Database Fields folder and
the LineItem table to open
them so you can navigate

their contents.
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Modify the Labels to Create Price Tags
The Format Editor window appears with the Font tab selected.

11 From the Style drop-down list, select Bold.

12 When finished, select OK.

13 Now let’s change the font of the Unit Price Level 1 Field. Select it, and right 
mouse click. Select Font.

14 In the Font Editor, Use the Font drop-down list to select Arial (or some other 
sans serif font you fancy more).

15 Use the Style drop-down list to select Bold.

16 Use the Size drop-down list to select 16 points.

17 Use the Color drop-down list to select Red.

18 When finished, select OK.
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19 Next we want to insert an “Our Price” marker. Select the Insert Text Object 
button in the Standard toolbar, and then drag the object frame to the far left 
side of the Detail c section. (We’ll discuss object frames in further detail in the 
next lesson.)

20 Click once to place the frame in the section.

21 A text cursor appears at the right side of the object frame. Type in the 
following: “Our Price: $.”

22 Select the object frame, and then right click. From the pop-up menu select 
Font. Now make the font settings exactly as in steps 11 through 16.

23 The text will probably appear a bit cut off at the bottom, so select the bottom 
frame handle (the small black square at the top of the frame), and drag it 
downward until you can see the text plainly.

24 Select the object frame, and move it up so that it more or less aligns with the 
UnitPriceLevel1 field.

Select the frame
handle to change the
size of a frame. The
cursor will turn to a

double-headed
arrow.
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25 To make more precise adjustments, we need to go to the Preview tab.

26 Our labels look pretty good already, but first we need to expand the “Our 
Price” object frame so that the dollar sign shows, making sure that there is a 
slight space between the “Our Price” object frame and the PriceLevel1 
object frame. Select the first “Our Price” object frame in the window. When 
the frame handles appear, click on the one at the right side of the frame, and 
drag the frame to the right.

When you increase
the width of the

“Our Price” object
frame, make sure

there is a slight space
between the two

object frames.
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27 The “Our Price” field is rather far away from the dollar sign, so let’s close up 
the space. Select the PriceLevel1 field (in the illustration above, it would be 
the 129.99 value). When the object frame appears, click the Align Left 
button in the standard toolbar at the top of the window. 

This way, if the PriceLevel1 field has a large value in it (1,000.00 or more), 
the field will expand to the right to accommodate the longer string of 
numbers. Our price tags are now complete.

28 Finally, from the File menu, select Save As, and save the report under the 
name “Price Tags.”

Review of Lesson 1

Let’s review some of the ideas we covered in Lesson 1:

• Since the standard reports that come with Crystal Reports for 
Peachtree are read-only, if you want to customize one of the reports, 
you must first save it under a new filename.

• When you are working with data fields within a report, select them and 
right click to see a pop-up menu that lets you format, delete, and copy 
fields, as well as perform other functions.

• To insert data fields, use the Insert Fields button in the Standard 
toolbar. To insert text fields, use the Insert Text Object button in the 
same toolbar.

• To move a field, first select it. The cursor will change into a cross with 
four arrowheads, indicating that you can now manipulate the frame. 
To move the frame, simply drag and drop it. 

• To expand or contract an object frame, select the frame; click the 
appropriate frame handle (at either right, left, top, or bottom of the 
frame); and then drag and release the frame.

Compare this
illustration with the

one above. Note that
the  129.99 value has
moved to the left as a

result of left
alignment.
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Lesson 2—Designing a Customer Contact List
The second lesson covers the design of a contact list you can use to help keep 
track of your customer base. It will list customer company name, contact name, 
and phone.

Select the Report Database

First we need to select the tables whose database information we’ll use to build 
the report.

1 If Crystal Reports isn’t currently running on your computer, start it now. (If 
Crystal Reports is already running, select New in the File menu.).

2 In the Create a New Crystal Report Document box, select As a Blank 
Report, and then select OK.
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3 In the Data Explorer, double-click the Database Files folder; then double-
click Find Database File.

4 In the Open window, use the Look in drop-down list to navigate to the folder 
containing your Peachtree company files.

5 From the list of Peachtree DDFs, select File.DDF, and then select the Open 
button.

6 From the list of displayed tables, select Customers; either double-click it or 
select the Add button.

7 Now do the same for the Company table. Select the Company field, and 
either double-click it or select the Add button.

8 When finished, select Close.
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Select the Report Database
The Visual Linking Expert appears with the two chosen tables displayed. 
All fields in the tables are listed in scroll boxes.

9 The Crystal Smart Linking feature is turned on by default. If you keep it turned 
on, which is recommended, Crystal will automatically link any fields that can 
be linked within the tables. You can change or add links as desired. In this 
case, none of the fields between the two tables needs to be linked, so just 
select OK to close the window.

When you select OK, you will see a message stating, “Your current link 
configuration contains multiple starting points. Please be advised that this is 
generally not supported.” This will not cause a problem in the report we’re 
designing. Select OK to remove the message.

The chosen tables are
displayed as scroll boxes.

Within each box are listed
all the fields in the table.

When needed, you can
link fields between or

among database tables.

Note
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Once you clear the message, the Report Designer appears with the Field 
Explorer window open.
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Select and Insert Fields

Now we want to place the appropriate fields in exactly the right spots within the 
report.

1 Double-click Database Fields and then Customers.

2 From the list of customer fields, select Customer ID, and then drag it to the 
far left of the Details section of the Report Designer. 

An object frame with the cursor shaped like an arrow appears as you drag 
the field.

3 To insert the field, release the mouse button.

The column header text, 
underlined, appears in the Page 
Header section above the field 
name. This is how the column 
header will appear on the printed 
or previewed report.
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Note the following:

• The object frame indicates that when the report is either printed or 
previewed, the field value will appear where the field name now 
appears.

• The width of the object frame indicates the maximum allowable width 
of the printed or previewed field. It is set to display the maximum 
number of characters in the field, but you can change this by resizing 
the object frame.

• The field name is repeated above, underlined, in the Page Header 
section. This represents the column header text for the field and is how 
the header will appear on the printed or previewed report.

• The font and style used in displaying both the field value and the 
column header indicate the font and style selected for the characters 
that appear in both these elements. Later, we’ll tell you how to change 
the font and style of text characters.

4 Now we want to add two additional fields to the report. In the Field Explorer 
window, select the Contact field; press the Ctrl key; and then select the 
Phone_Number field. Drag the fields and place them to the right of the 
CustomerID field.

As you drag the fields, an object frame appears with the cursor shaped like 
an arrow atop stacked sheets of paper marked with a plus. This indicates 
that you are inserting multiple fields at once.

5 Click the mouse button to insert the fields.

The fields appear in the same order in which you selected them in the Field 
Explorer window, namely, Contact followed by Phone_Number.
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6 Next we want to place the company name at the top of the report. In the 
Field Explorer window, double-click Company to open the Company table, 
and then double-click the CompanyName field.

7 Drag the field to the Report Header section, and click to place it at the top of 
the section, centering it within the section.

The field name aligns with the left side of the object frame.

8 To center the field name so that the company name is centered on the 
printed or previewed report, select the object frame and then select the Align 
Center button in the Formatting toolbar.

The field name is now centered in the object frame, indicating that the 
field will be centered on the printed or previewed report.

To center the company
name, select the object

frame around the
CompanyName field, and

then select the Align Center
button in the toolbar.
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Title and Preview the Report

Finally, we want to add a title to the report. To do so, we’ll need to slightly 
increase the size of the Report Header section. 

1 Place the cursor on the dividing line between the Report Header and Page 
Header sections.

The cursor now has double arrows, indicating that you can use it to move 
the divider between sections.

2 Hold down the left mouse button, and move the dividing line down perhaps a 
quarter of an inch, just enough to insert the report title.

3 To insert the title, click the Insert Text Object button in the Standard 
toolbar, and drag the cursor to the space just below the CompanyName 
field. Click the mouse button.

An object frame appears with the text cursor at the left side of the frame.

4 In the object frame, type “Customer Contact List.”

The cursor with double
arrows indicates that you can
now move the section divider
up or down, thus increasing
or decreasing the size of the

section
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5 Next, let’s center the title just as we did the CompanyName field. Select the 
object frame around the report title, and then click the Align Center button.

The text appears centered within the object frame.

6 Now we want to change the font and style of the report title. Select the 
object frame around the title, and then right mouse click.

7 From the pop-up menu that appears, select Edit Text Object.

8 When the text cursor appears, select the “Customer Contact List” text to 
highlight it, and right mouse click again.

9 From the pop-up menu that appears, select Change Font.
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The Text Format window appears with the Font tab selected.

10 From the Style drop-down list, select Bold.

11 From the Size drop-down list, select 18 points.

12 From the Color drop-down list, select Maroon.

13 When finished, select OK.

14 The title will be a bit off center, so select the object frame; drag it to center it; 
and then release the mouse button.
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15 Now let’s preview the report to make sure it will look all right when printed. 
Do one of the following: 

• From the File menu, select Print Preview.

• From the Standard toolbar, select the Refresh button.

A new tab, the Preview tab, appears. It shows how the report will look in 
printed form.

To make any desired changes, such as changing the placement of fields for a 
more esthetically pleasing effect, select the Design tab, and work with the fields 
there. As you learned in Lesson 1 (page 35), it’s possible to change report 
elements on the Preview tab, but it’s generally easier working on the Design tab.

16 Finally, from the File menu, select Save As, and save the report under the 
name “Customer Contact List.”
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Review of Lesson 2

Let’s review some of the ideas we covered in Lesson 2:

• Use the Data Explorer window to find the DDF that contains the 
database tables you want in your report. Use this window also to find 
and select the tables you want to include.

• If you have the Smart Linking feature turned on (which is 
recommended), Crystal Reports will automatically link the selected 
tables for you, if links are possible.

• To add fields to the table, use the Field Explorer to find and select the 
appropriate fields within the included database tables. You can select 
multiple fields by highlighting the fields and then selecting the Ctrl 
button. 

• To resize any of the sections in the report, just select the section divider, 
and holding down the left mouse button, drag the divider to the 
position you want.

• To center text within an object frame, use the Align Center button.

• To add text to the report, use the Insert Text Object button

• To change the font properties of a text object, select the object and right 
mouse click. From the pop-up menu, select Edit Text Object. 
Highlight the text; right click again; and select Change Font. When the 
Font tab of the Text Format window appears, make the appropriate 
changes.

• To preview a report before printing, select Print Preview from the File 
menu, or select the Refresh button in the Standard toolbar.
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Lesson 3—Designing a Quotes Good Through List
The third lesson covers the design of a list of quotes issued to customers 
arranged by good-through (quote expiration) date. The report will list the initial 
date of the quote, the customer, the quote amount, and the good-through date.

To show more of the design capabilities of Crystal Reports, this time we’ll let the 
Report Expert guide us.

Use the Report Expert to Build the Report

1 From the File menu, select New.

2 In the Create a New Crystal Report Document box, select Using the 
Report Expert. 

3 Note that in the Choose an Expert box, Standard is preselected. This is 
what we want, so click OK.
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The Standard Report Expert window appears with the Data tab selected.

4 The Expert asks you to select a data source. Click the Database button.

5 Double-click the Database folder to open it, and then double-click the Find 
Database Files icon.

6 In the Open window, use the Look in drop-down list to navigate to the folder 
containing your Peachtree company files.
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7 From the list of Peachtree DDFs, select File.DDF, and then select the Open 
button.

8 From the list of displayed tables, select Company. Then hold down the Ctrl 
key, and select Customers, JrnlHdr, and JrnlRow. Click the Add button.

9 When finished, select Close.
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The Links tab appears, asking you to link the tables as needed. 

10 With Smart Linking turned on (which is the default), the Expert has linked the 
PostOrder field in the JrnlHdr and JrnlRow tables and the CustomerRecord 
fields in the JrnlRow and Customers tables. Accept these links by selecting the 
Next button at the bottom of the window.
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When you select Next, you will see a message stating, “Your current link 
configuration contains multiple starting points. Please be advised that this is 
generally not supported.” This will not cause a problem in the report we’re 
designing. Select OK to remove the message.

Once you clear the message, the Fields tab appears.

Note
53



Designing Crystal Reports: A Tutorial
Crystal Reports for Peachtree Getting Started Guide3
11 In the Available Fields box, double-click the Customer.DAT (Betrieve) folder 
to open it; then double-click the Customers table to open it. Select the 
CustomerID field, and then click the Add button.

The CustomerID field moves to the Fields to Display box at the right side 
of the Fields tab.

12 In the Column Heading box toward the bottom of the window, insert a 
space between “Customer” and “ID” so that the column heading will read 
“Customer ID.”

13 In the Available Fields box, double-click the JrnlHdr.DAT (Betrieve) folder to 
open it; then double-click the JrnlHdr table to open it. Press the Ctrl key, and 
select the GoodThruDate, QuoteIDForSales, TransactionDate, and 
MainAmount field, and then click the Add button.

14 Use the Arrow buttons above the Fields to Display box to place the fields in 
the following order (if they aren’t already):

• GoodThruDate

• CustomerID

• QuoteIDForSales

• TransactionDate

• MainAmount

15 Now we want to give the fields more identifiable names to act as column 
headings on the report:
54



Lesson 3—Designing a Quotes Good Through List
Use the Report Expert to Build the Report
• Select GoodThruDate, and in the Column Heading box, change it so 
that it appears as “Good Through Date.”

• Select QuoteIDForSales, and change it to “Quote Number.”

• Select TransactionDate, and change it to “Quote Date.”

• Select MainAmount, and change it to “Quote Amount.”

Use the Arrow buttons to 
change the order of the 
fields to display...

...and then enter the 
desired column heading 
text for each of the fields.
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16 When finished, select the Next button.

17 We want to group our data by the GoodThruDate field, so select it in the 
Available Fields box, and then click the Add button.

18 The preselected sort order and break are acceptable, so select the Next 
button.
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19 We want to include summary information to appear on our report, and the 
Total tab lets us do this. The Expert has intelligently preselected the 
MainAmount field as the field to summarize and has also checked the Add 
Grand Totals check box, which will give us a grand total area on our report. 
Both of these choices are acceptable, so select the Next button.
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20 The Top N tab lets us sort groups based on summarized totals. This could be 
useful if we wanted to see, for example, which sales rep made the most sales 
in a month, but for our current report sorting is not important. So select the 
Next button without making any changes to the settings.

21 Again, a chart would be valuable for visually representing sales per sales rep 
or per geographic area, but for our report charting is not important. So select 
Next without choosing a chart option.
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22 We want to make sure that only quotes appear in our report. To do so, in the 
Available Fields box, double-click the JrnlHdr.Dat (Btrieve) folder to open it; 
then double-click the JrnlHdr table to open it. In the list of fields, select 
JrnKey_Journal. This will tell Crystal that of all the company information 
contained in the journal header file, we want only quote information to 
appear in the report. Click the Add button. When finished, select Next.
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23 The last tab, the Style tab, lets you select a style for the report. This report 
might look good as a table, so from the Style box, select Drop Table. Then 
in the Title box, enter the report title “Quotes Good Through List.” When 
finished, select Finish.

Notice that the finished report is displayed on the Preview tab to show 
what it will look like when printed. To achieve the look seen above, you 
may need to make minor adjustments to the column headings. For 
information on how to do so, see the Crystal Reports User’s Guide, the 
“Quick Start” chapter.

24 Now test your memory. Insert the “Bellwether Garden Supply” company 
name on the report. If you don’t remember how, consult the section of 
Lesson 1 where we discuss putting the company name on a report.

Filter the Report

Finally, we want to add a parameter field, which will make the report more useful 
by limiting the amount of data displayed. The parameter field we want to add 
will filter the GoodThruDate field by a cutoff date so that no quotes with an 
expiration date earlier than the cutoff date will appear on the report.

For step-by-step 
instructions on 
using parameter 

elds, look up 
Parameter Fields” in 
e Crystal Reports 
elp index.
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Filter the Report
1 in the Standard toolbar, select the Insert Fields button. 

2 When the Field Explorer window appears, select Parameter Fields and right 
click. From the pop-up menu, select New. 

3 In the Name field, enter “QuoteExpirationDate.”

4 In the Prompting text field, enter “Enter desired Quote Good Through 
Date.”

5 In the Value type field, use the drop-down list to select Date.
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6 Click the Set default values button.

The Select or enter value to add box displays the current date (the system 
date from your computer). Since we want to limit the expiration date for 
quotes listed on the report to April 1, 2003, we want to select that date and 
then make it the default date for the report.

7 In the M/D/YYYY field, use the drop down list to display a calendar. 
Navigate through the calendar until you find April 1, 2003, and then select it.

8 Now, click the Right Arrow button next to the field to populate the Default 
values box with this date.

9 When finished, click OK, OK, and then Close.
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Now the report will include only those quotes with an expiration date that 
falls after April 1, 2003.

10 To see the effect of the filter we have added, select the Refresh button in the 
Standard toolbar; then click OK.

11 Finally, select the Save button in the Standard toolbar, and save the report 
under the name “Quotes Good Through List.”

Review of Lesson 3

Let’s review some of the ideas we covered in Lesson 2:

• The Report Expert lets you choose the database, database tables, and 
links that will operate in the report much as you would do if you had 
gone to the Database menu and selected Add Database to Report.

• The Fields tab of the Report Expert lets you add fields to the report and 
also select the order of those fields and the column headings that will 
identify them in the report.

• The Group tab lets you group all information in the report by one or 
more of the chosen fields.

• The Total tab lets you chose a field or fields that will provide summary 
information in the report. It also lets you chosen whether or not to 
include a grand total as part of the summary information.

• The Top N tab lets you sort groups based on summarized totals. This 
could be useful in the case of reports reflecting information such as 
sales, where you will want to track sales reps or units doing the best 
business.

• The Chart tab lets you add a chart to the report, a visual representation 
of facts and figures in the report.

• The Select tab lets you use one or more of the fields to filter the 
information that appears on the report. This will limit the amount and 
nature of data you see.

• The Style tab gives you a variety of formatting options for your report.

• If you want to further limit the data appearing on the report, adding 
one or more parameter fields to the report will be the answer. Go to the 
Field Explorer; select Parameter Fields; right click; and select New.
63



Designing Crystal Reports: A Tutorial
Crystal Reports for Peachtree Getting Started Guide3
64



 • Index •
A
accessing standard reports 5
adding database tables to a 

report 23
Align Center button 43, 45
aligning

fields 43, 45

B
basics overview 2, 22

C
changing fonts 32, 45
charts on reports 58
column headings 54, 55
Crystal

Report Expert 49, 50
Smart Linking 52

Crystal reports
in a network 7
limit data access 8
previewing 17, 47
standard 4, 7
standard, access 5
standard, printing 18
standard, where stored 4
write access 8

Crystal Reports Design window 
18

Customer Contact List 37
Customer Detail List 10
Customer Sales by Item 12

D
.DAT files 23
data dictionaries 22
data dictionary files 23

selecting 38, 51
databases, selecting for reports 

37

DDFs 23
selecting 38, 51

designing
Customer Contact List 37
Quotes Good Through List 

49

E
editable versions of reports 28
editing text objects 45

F
fields

aligning 43, 45
grouping data by 56
inserting 41
inserting multiple 42
order on reports 54
parameter 60, 61, 62
selecting 41, 51
to display on report 54

filtering reports 1860, 61, 62
fonts, changing 32, 45

G
grand totals 57
grouping data by field 56
groups, sorting based on 

summarized totals 58

I
inserting

fields 41
multiple fields 42
text objects 34, 44

Inventory Labels 13
modify 31

L
limit data access 8

linking database tables 23
links 23

M
Maintain Users, limit data 

access 8

N
network 7
No printer check box 19

O
object frames 42

P
parameter fields 60, 61, 62
Peachtree, Maintain Users 8
Preview tab 18, 47
previewing

Crystal reports 17
reports 47

price tags 31
Print Preview 47
printer setup 19
printing standard Crystal 

reports 18
Purchases by Unit Price 14

Q
Quotes Good Through List 49

R
read-only versions of reports 28
Refresh button 47
Report Expert 49, 50

Chart tab 58
Group tab 56
Links tab 52
Select tab 59
65



Index
Crystal Reports for Peachtree Getting Started Guide
Report Expert (continued)
Style tab 60
Top N tab 58
Total tab 57

reports
charts 58
filter 18
filtering 60, 61, 62
grand totals 57
in a network 7
limit data access 8
making editable versions 

of 28
previewing 17, 47
sections 31
selecting databases 37
selecting subsets of data to 

appear 59
standard 4, 7
standard, access 5
standard, where stored 4
styles 60
summaries 57
write access 8

REPORTS.ZIP 4

S
Save As 28
Save data with report option 17
sections, report 31
selecting

databases for reports 37
DDFs 38, 51
fields 41, 51
subset of data to appear on 

reports 59
setting up printer 19
Smart Linking 26, 39, 52
sorting groups based on 

summarized totals 58
standard reports

See also reports, Crystal 
reports 4

styles, report 60
subsets of data to appear on 

reports 59
summaries on reports 57, 58

T
tables 23
text objects

editing 45
inserting 34, 44

V
Vendor Detail List 15
Visual Linking Expert 26, 39
Void Check Register 16

W
write access 8
66


	Overview
	What’s in This Guide

	The Standard Crystal Reports
	Where the Reports Are Stored
	How to Access the Reports

	Using Crystal Reports in a Network
	Special Network Conditions
	Limit Data Access to One User

	Standard Crystal Reports
	Customer Detail List
	Customer Sales by Item
	Inventory Labels
	Purchases by Unit Price
	Vendor Detail List
	Void Check Register

	Previewing Crystal Reports
	Set Up Reports to Appear in Preview Mode
	A Note about Printing Standard Crystal Reports

	Overview
	Data Dictionaries
	Data Dictionary Files (DDFs)
	Tables and Links
	How to Add Tables and Make Links


	Lesson 1—Modifying Inventory Labels to Create Price Tags
	Use “Save As” to Create a Working Version of the Report
	Modify the Labels to Create Price Tags
	Review of Lesson 1

	Lesson 2—Designing a Customer Contact List
	Select the Report Database
	Select and Insert Fields
	Title and Preview the Report
	Review of Lesson 2

	Lesson 3—Designing a Quotes Good Through List
	Use the Report Expert to Build the Report
	Filter the Report
	Review of Lesson 3


